Contents
Preface .............................................................................................................4
Welcome to Creatures 2 ..................................................................................4
Installing Creatures 2 ......................................................................................5
Before you start .......

5

The installation process ........................................................................................................................5

Creatures 2 – The summary .............................................................................6
What am I trying to do? ........................................................................................................................6
Albia in a nutshell ...

6

Norn care in a nutshell ..........................................................................................................................7

Playing Creatures – The ﬁve step guide ..........................................................8
STEP 1: Hatch an egg .............................................................................................................................8
STEP 2: Teach a few basics, and name your Norn ...........................................................................9
STEP 3: Lots of talk ............................................................................................................................... 11
STEP 4: A little care and exploration ................................................................................................ 15
STEP 5: What to expect – Breeding them ....................................................................................... 19

Creatures 2 –The sequence of events ............................................................20
Some things you’ll need to know ..................................................................21
Selecting a Norn...

21

The status bar and toolbar manipulation ..................................................................................... 21
Keyboard short-cuts and full screen mode ................................................................................... 22
Illness ......................

22

Albia ...............................................................................................................23
Plants and Animals ............................................................................................................................. 24
Creatures ...............

25

Creatures 2 and the Internet .........................................................................26
Internet resources

26

Exchanging Norns on the Internet .................................................................................................. 26
Adding new objects............................................................................................................................. 26

Credits ............................................................................................................27
2 - Creatures 2

A huge living world, and six Norn eggs waiting to be hatched. Begin with your ﬁrst baby
Creature and start exploring Albia for the ﬁrst time. With dangers lurking around every
corner, you’re going to have to be on your guard if you and your family of Norns are ever
going to build a peaceful existence. Ultimately, you may even ﬁnd the genetic splicing
machine, and your chance to rid Albia of the menace of the vicious Grendels forever.
They’ll make you laugh.
They’ll make you cry.
They’ll make you think.
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Preface

Installing Creatures 2

Albia has been injured, its surface ripped away by a devastating volcanic eruption. But
that is not all… The secret laboratories of the ancient race of Shee, together with all of
the deserted experiments and machinery, have been revealed after earthquakes tore the
land apart. The legacy of the Shee may hold the only hope for the Norns of Albia. Explore a
dangerous and exciting new world, leading to the discovery of the place where the Norns
themselves were created.

Creatures 2 comes on one CD-ROM, complete with facilities to automate installation. Insert
your Creatures 2 CD, follow instructions, and you should be hatching your ﬁrst Norn in just
a few minutes!

Welcome to Creatures 2
Creatures 2 contains the most advanced artiﬁcial organisms ever created. Each Norn you
hatch comes from its own Digital DNA, and
Sounds enormously complex. Is it?
contains the same chemicals and organs that
you would ﬁnd in a real living animal. Their
brains allow them to think for themselves,
developing the skills to survive in the wild.
Eventually, they may breed and have their own
children and each child will then have its own
unique DNA.
Your goal is to create a thriving population of
Norns. To ﬁnd all the food and activities your
Norns will need to live long, healthy lives, you’ll
have to explore Albia. You’ll be battling against
the weather, and a collection of plants and
animals with their own agendas for survival.
At some point, you’ll bump into the vicious
Grendels – disease ridden, violent creatures
created by accident by the Shee many
thousands of years ago. Scattered around
Albia are new machines and devices to help
you with your Norn care. Ranging from the
Science Kit that allows you to monitor their
biochemistry, and the Neuroscience Kit that
lets you tinker with their brains, you may even
ﬁnd the key to controlling the Grendels on
Albia: The genetic splicing machine!
Norns… Breed them. Teach them. Explore with
them. Learn with them.
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No, not really. Creatures 2 creates virtual
animals that behave just like real animals.
This actually makes them easier to
interact with, because they do what you’d
expect them to do. This would be a very
complicated thing to do if we had to
program each and every action a creature
could take. Indeed, this is the way that
most people have created artiﬁcial animals
before. The catch is, that “every action” is
a lot of actions and you couldn’t get your
creature to do anything we hadn’t thought
of and programmed for. So in Creatures
2, we modelled the building blocks of life
itself and used these building blocks as
a sort of “biological construction set” to
make animals out of. Every Norn, Grendel
and Ettin in Creatures 2 is its own living
system, complete with a bloodstream,
brain and body organs. The genetic code
for the creatures is called Digital DNA, and
allows your creatures to actually evolve
over time. With over 550 individual genes,
and hundreds of trillions of possible
genetic combinations the sky really is
the limit. With millions of Norns getting
exchanged on the Internet, it is possible
that you could be the ﬁrst Creatures 2
owner to breed a Norn far more intelligent
than the ones you’ll start with! The bottom
line is that nature is very good at making
animals: So we’ve copied nature!

Before you start
To install Creatures 2, you will need:
• Windows 95, Windows 98 or Windows NT 4
(Service Patch 3 or higher required for NT)
• 16 MB of RAM
• 200 MB of free hard drive space
• 16-bit video card with at least 2 MB of video RAM.
Microsoft DirectX compatible drivers required
• 16-bit sound card and Microsoft DirectX compatible drivers

The installation process
Start your computer. When Windows has loaded, insert the Creatures 2 CD-ROM. After a
few seconds, you will see this window appear:
Click on the Install button and follow instructions. If you do not change any of the defaults,
the Set-up program will install Creatures 2 on your C: drive in the “Program Files\Creatures
2” folder.
During the installation process, Set-up may need to install Microsoft DirectX onto your
computer. DirectX is required before Creatures 2 will work, so if you are not sure if you
already have it, click on the Yes button when asked if you would like to install DirectX.
After installation is complete, you may need to restart your computer. Usually, this is as a
result of DirectX making changes to your video and sound drivers to allow Creatures 2
to function correctly. If you are asked to restart, remove your Creatures 2 CD, restart your
computer and then re-insert the CD once Windows has loaded.
You can now either run Creatures 2 by clicking on the Run Creatures 2 button on the
above dialog, or through the START menu:
You’re now ready to hatch your ﬁrst Norn!
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Creatures 2 – The summary
For those who want to get started quickly, we recommend reading this page at the very
least!

Norn care in a nutshell
• Norns behave a lot like very young children. If you treat them a little like toddlers,
you can’t go wrong: Punish them when they make mistakes, and reward them
when they get things right.

What am I trying to do?
1. Hatch and breed some Norns. They die after around 10 hours, so you’ll need to
get them to breed in order to maintain a population of creatures.
2. Explore Albia and ﬁnd the secret machinery. To live long enough to breed, your
Norns will need to explore Albia. Along the way you will ﬁnd new machinery and
devices to help you.
3. Ultimately, you will have access to the genetic splicing machine that allows you
to mate two Creatures together and create an instant crossbreed. This includes
Ettins and Grendels!

Albia in a nutshell
An Albian year lasts 8 hours, divided into 4 seasons of 2 hours each. Each season contains
4 days. Day, season and temperature are shown on the status bar at the base of the main
Creatures 2 window.
You are represented in Albia with the Hand graphic. You move this around using the
mouse. You can interact with a lot of the objects in Albia by positioning the hand over
hotspots and clicking once with the left mouse button. You can pick a lot of objects up
by moving the hand over an object and clicking once with the right mouse button. Click
again to release. BUT: You cannot pick Norns up unless they are drowning in the ocean. You
cannot drop a rescued Norn in a place you have not yet visited.
You can see what an object is by moving the hand over the top of it and waiting. The
word in square brackets is the name of the category, the word before is the name that the
currently selected Norn has learnt for that object.

Punishing a Norn by clicking
on her bottom. The devil icon
indicates punishing a Norn.

Rewarding a Norn by clicking on
her nose – note the angel graphic
on the hand to denote a reward.

• You can reward a Norn by tickling it on the nose (click on their nose) and you can
punish one by clicking on their bottom.
• Norns live about 10 hours, and reach adolescence after about 1½ hours. After this
point, they have the potential to breed.
• To see what a Norn is looking at, select “Creature’s Eye View” from the “Camera”
menu. Norns can be taught the names of objects by typing a name for an object
whilst the selected Norn is looking at it (Norns may not get it ﬁrst time – you can
repeat the last thing you typed by holding CTRL down and tapping the ‘S’ key).
Concepts, such as look, eat and hit can be taught using the learning machine
computer. Words for feelings, such as hungry, lonely and scared can be taught
using a second computer underneath where your Norns ﬁrst hatch (use the
elevator to the right).

This learning computer teaches
concepts (verbs) such as look, get,
eat and push.

This learning computer teaches
feelings, such as cold, lonely,
hungry and frightened.

When you have taught a Norn to speak, you can better understand their needs
and you can also talk to them by issuing commands like “Alice eat food” to suggest
actions for them. Of course, they may not always pay attention to you!
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Playing Creatures – The five step guide
This section of the manual guides you through the birth and early stages of your ﬁrst Norn.
Once you’ve worked through this, the next section will give you more details of Norn care
and information about living in Albia.
The Creatures 2 display consists of a main program window, a status bar, toolbar buttons
to allow quick access to program features and some menu options. When you start
Creatures 2, you’ll get a Tip of the day. You can turn these off by un-checking the “Show tips
at startup” on the tip of the day dialog window. The main window looks like this:

STEP 1: Hatch an egg
Click on the Hatchery button on the toolbar to
view the six eggs you start with:
The Hatchery will appear after a second or
two. You have a total of 6 eggs initially, 3
containing female Norns and
three containing male Norns.
When you run out, you will be
prompted and asked if you’d
like additional eggs.
If you move your mouse
pointer over the eggs, you can
see if they are female or male.

Female
egg

Male
egg

Double click on an egg to transfer it into Albia. For the purposes of this guide, we’ll hatch a
female.

If I can get new eggs easily, why do I only have 6 in the Hatchery?
Life is precious, and the power of natural selection and evolution is incredible.
If you keep going back to “generation one” (i.e., your originals) Creatures, then any progress
nature has made with your Norns will be wiped out. The best bet is always to
breed naturally, as that way, only the strongest Digital DNA will survive.

Pick the egg up by moving your hand over it and
clicking once with the right mouse button. Then
move the hand over the Incubator object and click
on the right mouse button once more to release the
egg. If the egg doesn’t drop into the incubator, try
again paying careful attention to where you release
the egg.
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The egg will take about 30 seconds to hatch, which is
the time it takes for Creatures 2 to work through the
Digital DNA and build a new creature from scratch.
Your Creature will be unique, its DNA is taken from
a combination of two parent DNA strands that we
include on your CD-ROM. When she is born, she
won’t know how to eat, how to breed or how to
protect herself. She will feel pain, feel scared, bored
and hungry, only she won’t know why at ﬁrst. By
experimenting, playing, trying things and exploring
– and with your help – she’ll gradually learn how to
survive.

Will eggs hatch in the wild?
Yes, but it will take some time. It
is always quicker to put eggs into
the incubator object to hatch them
– however, if you just leave the
eggs around, they will eventually
hatch in the wild unless you touch
them. Once you’ve touched them,
though, they go into a state of
suspended animation until they
are placed in the incubator! TIP:
This can be used to store eggs and
prevent them from hatching until
you want them to!

Soon, she’ll pop out of the egg. You’ll see a BIRTH
event appear on the event toolbar. You can double
click on this to accept the event – but don’t do that just yet!

STEP 2: Teach a few basics, and name your Norn
Select Creature’s View from the Camera menu. Another window will appear. Move this to
somewhere out the way on your screen, but where you can still easily see it. The object in
the middle of this new window shows you what your Norn is looking at. Wave your hand
around near to your new born Norn. The more exaggerated you can make the movements,
the more the hand will stand out to your baby creature.
After a few seconds of this, you
should see the creature focusing
her attention on your hand. Making
sure that the Norn is still looking
at your hand, and the Creatures
2 main window is selected, type
“daddy” (or “mummy” if you are a
female Norn parent!).
You may need to repeat the word
several times before she learns it.
You can hold the CTRL key down
and tap the ‘S’ key to repeat the last thing you typed. All being well, after a few times she’ll
learn the name for the hand.
You’ll ﬁnd that if your Norn is looking at something else, you can encourage her to look at
your hand just by typing in the word you named it, in this case “mummy.” This will tempt
the Norn to focus her attention on the hand. This works with any object once it has been
named, incidentally, so once your Norn knows the word for food you can type “food” to
tempt her to direct her attention at it.
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Let us teach your Norn to follow the hand
object. Tickle her on the nose by clicking on
it. The hand shows a little angel graphic to
indicate that you are positioned correctly
over her nose. If you see a red devil instead,
you’re positioned to slap your Norn – which
you do when she misbehaves.
Now move the hand away. If she walks
towards it, tickle her again and repeat the
process. She enjoys it, and she’s learning
that if she walks towards the hand, she gets
a nice tickle. It is a little like attracting a
toddler with candy! If she doesn’t want to
pay attention, try slapping her brieﬂy and
repeating the process.

Hey! This is difﬁcult!

When you have typed in your information, click on the Register Birth button to register the
creature’s birth. This will also teach your Norn her name, in this case, Alice.

I can’t make her look at the hand.

STEP 3: Lots of talk

Persevere! Try clicking on the Norn’s nose to give
her a tickle, and then wave the hand around
her head a few times. As soon as she focuses
her attention on your hand, tickle her again to
reward her for doing that. If you really have no
luck, try hatching a new Norn and trying again.
You can always come back to this Norn later.
If you want to get your ﬁrst Norn out the way,
export her using the File menu. This places her in
a ﬁle on your hard drive. You can always import
her back into your Albia later when you have
more experience as a Norn parent.

The process we used in Step 2 to name the hand can be used to name any object in Albia.
The catch is, you have to wait until your Norn decides to look at an object before you can
name it. This can be enormously time consuming if you have an uncooperative Norn!

Now it is time to name her.
Double click on the BIRTH event. This opens the Owner’s Kit applet and automatically
makes the appropriate Norn the currently selected one (you can only have one of your
Norns selected at once).
There are eight of these applets; each designed to help you
with a speciﬁc aspect of Norn care.

Useful tip! Norns not paying attention? Try waving an object around in front of them, or
throwing it on the ﬂoor near to them – either way, this can be highly effective at attracting
attention to an object before you’ve taught your Norns to speak properly.

Fortunately there is an easier way. Norns are able to learn to associate words with basic
concepts such as “pull”,“eat” and “look”. Once they know these words and what they mean,
they are able to use them in conversation as well as responding to them when they are
typed in.
There is a learning computer just to the right of the incubator that can be used to teach
your Norn names of concepts. Each word in the computer has its own page, and you can
cycle through the pages using the left and right buttons. There is also a button to repeat
the current on-screen word.

The Owner’s Kit deals with birth registration, photograph
album and general information about your Norn’s life.
Click on the tab labelled Owner to enter birth registration
information.
Name your Norn by clicking in the name box and typing
a choice. You can also enter details about yourself as
the parent below that. This information can then be
used to identify the parents of any given Norn when it is
transferred over the Internet.
Caution: BE CAREFUL as to how much information about yourself you give away! If you
decide to exchange your Norns over the Internet, all of the information you give on this
screen will be transferred too. So think twice before effectively publishing your e-mail
address and real name on the Internet.

The Learning Computer. Both types (one for concepts, one for feelings)
operate identically but have different word lists.

Useful tip! Once you’ve had a lot of Norns, it can become difﬁcult to keep track of which
generation they are. Try naming your ﬁrst creatures with names beginning with ‘A’, and their
children with names beginning with ‘B’. That way, you can easily identify which generation any
given Norn is.
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Concepts may need to be repeated several times before a Norn learns the word. Words you
may wish to teach your Norn early on are:
Look

Encourages a Norn to look at an object.

Eat

Asks a Norn to eat an object.

Come

Asks a Norn to approach an object.

You can teach your Norn these words by getting her to the learning computer, and then
cycling through the various pages until you come to the above words. Then repeat them
several times, remembering to tickle your Norn occasionally if she is a quick learner.
Watch out for her playing with the machine too! There is a separate row of buttons on the
learning machine low enough for your Norn to operate!

Useful tip! Hey! My Norn ignores me. When you issue a sentence, if your Norn ignores you,
try slapping her on the bottom and then re-issuing the command. When she ﬁnally obeys,
remember to reward her so that she learns that obeying you is a good thing to do!

Over the ﬁrst hour or so of a Norn’s life, you’ll want to teach her names to many of the
objects so that you are able to communicate with her effectively. Important! Objects in
Albia are categorised! This means that cheese and honey are both Processed food. Norns
are only able to understand categories. You can ﬁnd out what category any object is
simply by holding the hand over it for a second or two. The table below lists the categories
and some example objects that are in them:
Category

Examples

Category

Examples

Useful tip! When young, Norns may learn what the words are before their meaning.

System

Hand.

Button

Elevator call button.

This does not necessarily mean your Norn will never understand that word, it might
just mean that the genetic instinct has not been processed yet.

Nature

Waterfalls, waves and torches.

Good plant

Tomato plant, nut plant.

Creature Eggs

Norn, Grendel and Ettin eggs.

Processed food

Cheese, honey.

Food vendor

Cheese dispensor

Drinks

Water pump, water fountain.

Implements

Seed launchers, doors and
pick-ups.

Detritus

Mouldy food.

Medicines

Pill bottles and other
medicines.

Toys

Balls, toy car, toy dog.

Weather

Clouds, rain and snow.

Bad plant

Cactus, puff-ball.

Animal house

Ants nests, bee hives.

Dangerous bug

Ants, bees, gnats.

Harmless bug

Caterpillars, butterﬂies, snails.

Dangerous
critter

Bats, crabs.

Harmless critter

Fish, chameleons, rabbits.

Seeds

Cactus seeds, trifﬁd seeds, etc.

Roots

Carrots, potatoes.

Flowers

Spyro, Pear plant.

Fruits and berries

Pear fruit, arnica berries.

Vehicles

Submarine.

Up/Down
movers

Elevators.

Computers

Learning machines.

A/V Equipment

Gadgets such as clock and
calendar.

Left/Right
movers

Dingy, rowing boat.

Incubators

Incubator

Teleporters

Teleporters and other magic
devices.

Machinery

Large machinery such as gene
machine.

To talk to your Norn, move the hand so that it is relatively near to her and type a sentence.
For example:

Asking Alice to approach the hand object

Asking Alice what she is thinking and why

Using the Norn’s name at the start of the sentence is optional, but if you don’t use a name,
then any Norn within earshot will be able to hear your command! This can be useful
sometimes, but at other times when you wish to address your conversation with just one
Norn it is worth using the name to avoid confusion. You can use “look” to ask a Norn to
look at an object. This is an easy way of teaching your Norn the names of objects. If you’ve
taught your Norn the name for food, for example, you can then try sentences such as:
Alice come food
Alice eat food

Asks Alice to approach the nearest food object.
Asks Alice to eat the food.

… then by a process of issuing commands and rewarding good responses, you can quickly
teach your Norn how to survive.
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In the room below the Incubator room, you’ll ﬁnd a second learning machine that can be
used to teach the Norn to associate words with feelings and qualiﬁers. This is very useful, as
it will allow your Norn to tell you how she actually feels.
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The table below lists all of the various concepts you can teach your Norn and what they
mean:

STEP 4: A little care and exploration
Now you are ready to start exploring Albia. We recommend you just have the one Norn at
ﬁrst, to learn how to interact and explore a little before you hatch a partner. Norns are not
ready to breed until they are nearly 2 hours old, so you have plenty of time to wait!

Learning Machine for Concepts

Learning machine for Feelings

Push
(Activate an object.)

Pain
(Creature is in pain.)

Pull
(Activate an object.)

Sad

Stop
(Deactivate an object.)

Hungry

Come
(Approach an object.)

Cold

Run
(Retreat from an object.)

Hot

With a combination of temptation, commands and pushing and shoving you should be
able to easily explore all of Albia. Start by exploring the area around you, and familiarise
yourself with the two learning machines and the various toys around. Make sure you teach
your Norn how to eat!

Get

Tired

Navigating around Albia

Drop

Sleepy

What
(What are you doing?)

Lonely

Rest

Crowded

Left

Scared

Right

Bored

Eat

Angry

Look
(Focus attention on an object.)

Friendly
(Creature has high sex drive.)

Yes
(Reward a creature.)

Hurt
(Creature is injured.)

No
(Punish a creature.)

Choking
(Creature is suffocating.)

Why
(Why are you doing that?)

Thirsty
Stressed

Remember that once you have taught one Norn how to speak, other Norns will pick up
new words simply by listening! So teach a Norn well, and it will help you teach the others.

Useful tip! “what” and “why” are very, very useful!
You can ﬁnd out what your Norn is thinking and why!
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We’ve already introduced tickling and slapping, as well as use of words such as “come” and
“look” to tempt your Norn to explore. There are also other ways of interacting with your
Norns by using the Pointer toolbar:
This small toolbar can be used to change the action the hand has inside
Albia. There are two basic modes of operation

You will notice that you can only normally see areas of Albia where a Norn is. There are
some features that help you get back to places you’ve already visited at least once. The ﬁrst
method is by using the Ecology Kit applet, which you can start from the Tools menu or the
toolbar icon:

Select the Location tab, and then click on any of the colour areas of the map. These
coloured areas show the parts of Albia you’ve visited.
If you check the “Keep on top” check-box in the Ecology Kit (or any of the applets) then the
applet window will be kept on top of all the other windows.
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You can also mark favourite places so that they can easily be returned to using Add
favourite place on the Camera menu.

Favourite places appear on the toolbar, and can easily be selected and jumped to by
clicking on the button to the right of the drop-down favourite place box.

Using the applets for Norn care

Creature Graveyard
Like real animals, Norns do not live forever. Normally, they
should live for about 9 hours, but occasionally they may
die earlier due to accident, injury or illness. The Creature
Graveyard allows you to write a few words to remember
the dead with. You can even pick a photograph that you’ve
taken to place on the gravestone. The graveyard lets you look
through the gravestones. The Creature Graveyard can be run
by double clicking on a DEATH event on the status bar:
Breeder’s Kit

Remember you have access to the Owner’s Kit to take photographs of your Norn, or
perhaps look at the family tree.

Requires a Norn to be selected.

NOTE! You need to have a Norn selected to use many of the applets.
To select a Norn, pick a name from your Creatures menu, or click on
a Norn with the right mouse button. You can also use the TAB key to
select a Norn. Pressing TAB repeatedly cycles through all of your Norns.

The Breeder’s Kit monitors the reproductive processes inside
Norns. It also has fertility tests and pregnancy progress
indicators for female Norns. There is even a selection of
aphrodisiacs to help tempt stubborn Norns into mating.

There are also other applets you may wish to use that will help you with your Norn care. All
of them can be “kept on top” by checking the “Keep on top” check-box. This will ensure that
the applet window remains on top of all of your other windows.
Health Kit
Requires a Norn to be selected.
The Health Kit applet provides basic medical care for
your Norns. It has pages to monitor the state of internal
organs, and see whether your Norn is hungry, sleepy or
bored. There is also a selection of medicines that can
help cure or relieve a variety of illnesses.
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Observation Kit
The Observation Kit shows a list of all the Norns in Albia
together with some information about them, such as age, sex
and health status. This window is sizeable, so you can keep it
on screen all the time. Advanced users of the Observation Kit
can set alarms to go off when certain chemicals appear in the
Norn’s bloodstream.
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Ecology Kit

Neuroscience Kit

Albia has a complex eco-system, which can be
monitored with the Ecology Kit. The Ecology Kit
has pages that show complete maps of Albia
and allow you to view the temperature, wind
speeds and positions of organic and inorganic
nutrients – handy to ﬁnd out where plants may
grow.

Requires a Norn to be selected.
The Neuroscience Kit is a special advanced applet for
monitoring brain activity in Norns. With it, you can examine
the brain lobe layout and even ﬁre individual neurone cells
inside the brain itself.

Agent Injector
The Agent Injector allows you to add new objects into your
Albia. These objects can be downloaded from the Internet,
or purchased in add-on CD-ROMs. There is a special page so
you can check objects to see if they are dangerous before
injecting them into Albia.
There are two other applets that you don’t initially have
access to, although you can ﬁnd special objects inside Albia
that will enable them. They are highly advanced tools, so be
careful!

Enables the Science Kit
applet

Enables the
Neuroscience Kit
applet

Enables some
additional advanced
features in the Science
Kit applet

Science Kit
Requires a Norn to be selected.
The Science Kit is an advanced applet for monitoring a
Norn. It has pages to view the levels of chemicals in the
bloodstream and use a hypodermic needle to save an ill
Norn’s life. If you manage to enable the additional advanced
features of the Science Kit then you can inject any quantity
of any chemical, and view the genetic makeup of a Norn. This
can be useful for advanced medical care.
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STEP 5: What to expect – Breeding them
After your Norn reaches the age of around 2 hours, she will reach adolescence. This is a
confusing time for Norns, as all sorts of new genes switch on to allow them to breed. Both
male and female Norns start getting a sex drive, and have the potential to breed.
After you’ve got used to interacting with one Norn, you will probably wish to hatch a
partner of the opposite sex.

Useful tip! Train Norns in isolation at ﬁrst! Whilst you’re learning how to look after Norns, it
is much easier to teach them if you keep them away from other Norns. Norns ﬁnd each other
fascinating as they do interesting and unpredictable things, sometimes it can be hard to
separate them. If you’re ﬁnding it very difﬁcult to get two Norns apart, export one of them using
Export current Norn on the File menu. This will remove the selected Norn from Albia, and put
her on the hard drive. You can re-import her at a convenient moment when it is safer. Imported
Norns appear near the Incubator.

You can use the Breeder’s Kit to monitor the fertility and breeding process of Norns:
If a fertile male and female Norn meet each other, there is a
chance that they will mate – so long as their sex drive is high.
When Norns mate, you hear a long kissing sound with a pop
at the end – known as a kisspop! Just because they’ve mated
does not necessarily mean the female Norn will get pregnant.
You can check in the Breeder’s Kit to be sure.
Don’t worry if you don’t get a pregnant Norn ﬁrst time, it may
take an hour before you can coax them into breeding. Once
you’ve got your ﬁrst egg, you can either wait for it to hatch in
the wild, or drop it into the incubator as soon as the egg has
stopped growing.
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Creatures 2 –The sequence of events
A game of Creatures 2 can go on indeﬁnitely, as you can theoretically continue breeding
your Norns forever. Each generation of Norns has its own unique Digital DNA, so the
possibilities are potentially endless. Likewise, with Albia changing all around you, and with
the opportunity to add new objects and creatures into Albia from the Internet or from
add-on CDROM packs, Creatures 2 can evolve alongside you. To give you some idea of
how things develop over a typical game of Creatures 2, here is a table that shows a lifespan of a Norn and what you might expect as both the Norns and Albia develop. But do
remember that each and every game of Creatures 2 is different, and the table below is just
a guideline. Also note that Albian time is not always the same as real time, and they can be
different by as much as 25%!

Some things you’ll need to know
Creatures 2 is a very advanced and powerful product, even though it is designed to be
easy to use. There are many special program features that can increase your enjoyment
of the product. This section of the manual describes several of these features, as well as
talking about the status bar and some of the menu options in more detail.

HEY! I’ve got a Norn selected, but he walked off screen and now I can’t see him!
You’ve accidentally switched off camera tracking. Click on the Camera Tracking toolbar button,
or select Track current Norn from the View menu. You can also switch between smooth scrolling
(where the selected Norn always remains at the centre of the screen) or normal scrolling, where
your view of Albia is adjusted when the selected Norn walks close to the screen edge.

After

You should expect:

10 minutes

First Norn hatched, named and taught some basic words.

Selecting a Norn

30 minutes

First Norn knows most words and has explored a little. You could hatch
a second Norn at this stage. You’ve probably got access to the Science
Kit by now. Your ﬁrst Norn is entering late childhood.

You need to have a Norn selected in order to use applets such as the Science Kit, Health Kit
and Owner’s Kit. Creatures 2 will automatically change your view of Albia so that you can
see the currently selected Norn. Norns can be selected from the Creatures menu.

1 ½ hours

First Norn is an adolescent now and can potentially breed. It is now
late spring in Albia and warming up as summer approaches.

2 hours

Summer has arrived. Your two Norns meet for the ﬁrst time and start
getting to know each other.

3 hours

You’ve probably seen the ﬁrst baby Norn by now! Your ﬁrst natural
birth. It is mid summer, and there are butterﬂies ﬂying around
pollinating ﬂowers. You will probably have met the vicious Grendel
and the Ettins by now.

5 hours

You may have had several natural births now, and those second
generation Norns could even be breeding themselves. If you’ve been
exploring you’re likely to have found all of the new features, including
the Advanced Science Kit and Neuroscience Kit.

After that…

Albia will continue to change, your Norns will develop, and you’ll
eventually ﬁnd and learn how to use the genetic splicing machine
– allowing you to take two creatures (including Ettins and Grendels)
and cross-breed them to generate a new egg

.
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You can also use the TAB key to cycle between all of your Norns one at a time. The selected
Norn’s name is shown on the window title bar, and information as to her current state of
health is shown at the right of the status bar:

The status bar and toolbar manipulation
The Status Bar is at the bottom of the screen and is divided into three basic sections:

Albia information: Season,
Game year, Time of day, Temperature

Events: Laid eggs (EGG), Norn
births (BIRTH), Norn deaths
(DEATH). Double click on an
event to clear it and move to
the appropriate part of Albia.

Selected Norn information: Health
bar. Above 75% or so is good health. If a
Norn becomes critically ill, then this bar
will ﬂash red. This is normally the time
for some serious health care!

The indicator at the far right
of the Selected Norn Information (right hand side of the status bar) shows what is most
important to the selected Norn at any given time:
Tired

Bored

Need for pleasure

Cold

Crowded

Fear

Hot

Hungry

Injured

Lonely

Angry

Pain

Amorous

Sleepy

Stressed

Suffocation

Thirsty
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Both the status bar and toolbars can be switched on and off using the View menu.

Keyboard short-cuts and full screen mode
There are several keyboard short cuts designed to make using Creatures 2 easier. They are:
CTRL and S

Repeat the last piece of text you typed in.

TAB

Select a different Norn – pressing TAB repeatedly cycles through all of
your Norns

F1

Start help. This is context sensitive, so if you press it inside the Science
Kit you’ll get help on the Science Kit

F7

Toggle the Standard toolbar on and off

F8

Toggle the Pointer toolbar on and off

F9

Toggle the Applets toolbar on and off

F10

Toggle the speech history and favourite places toolbar on and off

F11

Toggle the status bar on and off

F12

Full screen mode on and off (if used in conjunction with F7 to F11 can
create a true full screen Creatures 2)

Arrow Keys

Scroll around Albia. If you hold SHIFT down at the same time, the
screen will move in larger chunks.

Illness
Albia is a wonderful exciting world, but it also contains dangers. From the vicious Grendel
lurking near the swamps, to the irritable bees that have a habit of stinging passing Norns.
Albia also has bacteria, the smallest of nature’s organisms. Some are trapped in caves and
others are carried by other creatures, such as the Grendels. If infected by germs, Norns can
catch diseases that can make them very ill. If your Norns start coughing and sneezing, or
running a fever, they could have caught a disease. You can use the Health Kit to monitor
their heart, and select from a variety of medicines.

Albia
Albia is a vast disc world. If you keep travelling to the right, the east, then eventually, you
will end up back where you started. Since the vast volcanic eruption, Albia has changed
considerably. Almost all of the old world was completely destroyed, and now the ancient
hidden laboratories of the ancient race of Shee (now, sadly, long since gone) are revealed
for the ﬁrst time.
Albia is just like a real world, it has seasons, days, nights, and weather. During the long
winter nights, it can get very, very cold outside. So cold, in fact, that even the sea itself
can freeze (giving Grendels a short cut to visit you…). Each of the plants and animals you
see has its own life cycle. Cacti need to be pollinated before they can seed each year, and
insects need ﬂowers to feed from so that they too can survive. This forms a huge, living
eco-system for your Norns to live in.
There are many things to discover, and this section covers some of the plants and animals
you may meet and introduces you to the Grendels, Ettins and Norns.

If you have gained access to the Science Kit applet, you can try some very advanced
medicine, including injecting your Norn with various medicines and other chemicals. It is
even possible to restart a Norn’s heart after it has stopped if you know the right chemicals
to inject!
If your Norn is ill, try and keep her in quarantine, away from other Norns, so that the
infection doesn’t spread – particularly if your Norn is sneezing, as that spreads disease very
quickly. Keep the ill Norn warm, and well fed to speed a recovery.
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Plants and Animals
There are many plants and animals to ﬁnd in Albia, and many of them will only live in certain
environmental conditions. Here is a selection of some of the things you can expect to see:
Spinnomosa

Likes warm, desert conditions, grows all year round (except
winter) in the mornings, produces ﬂowers at night.

Spikeocausius

Likes warm, desert conditions, produces ﬂowers in springtime
nights.

Pear plant

Likes temperate/sub tropical conditions, opens sepals during
the day to reveal a juicy fruit. Is dormant during winter.

Gelsemium

A strange mushroom type plant that grows in very few places
– the fruit is a valued medicine and will not survive off the
plant for very long if the conditions are not right.

Trofﬁd plant

This plant is a hardy species that can survive in a wide range
of climates. The fruit is good source of nutrition.

Carrot

A staple diet food for Norns and many other creatures in Albia.

Potato

Another root food source for Norns, high in starch.

Ant

Bat

Bee

Snail

Ants are known to
eat both carrots and
rotten fruit.

Bats only come out
at night, and can be
dangerous.

Bees are relatively
harmless unless
disturbed, in which
case, run!

Not much is known
about the Albian
snail, but it appears
harmless.

Jellyﬁsh

Zander ﬁsh

Goldﬁsh

Anemone

The Jellyﬁsh can be
highly dangerous if
touched.

These ﬁsh school
later in the year
before breeding.
They are very tasty
to Norns.

Albian goldﬁshes
have memories of
only a few seconds.

Anemones are
harmless, but tend
to wrap up and
hide when touched.

24 - Creatures 2

Creatures
The Norns

The Grendels

Created thousands of years
ago by the Shee, the Norns
are peaceful Creatures who
enjoy living and exploring.

An unfortunate side
effect of the Shee’s
experimentation in
Creatures led to the vicious
Grendel. And now there is
a new even more vicious
species of Grendel loose!

The Ettins

The Ettins were created
by the Shee to act as
constructors, builders and
workers. They have lost
most of this instinct over
the years, but can still be
very active.

New in Creatures 2 Deluxe are the Golden Desert Norns and the Frog Norns from the
Creatures Life Kits:
Golden Desert Norns

This variant loves the warm places of Albia,
despite its covering of thick warm fur.

Frog Norns

The Frog Norns must be injected as
frogspawn into Albia. The frogspawn will
hatch into tadpoles, which will grow ﬁrst
into froglets and then adult frogs. They
must not stray too far from their home
pond or they will die!
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Creatures 2 and the Internet
Creatures 2 has a wide range of expansion options, allowing you to exchange Norns and
objects over the Internet. There are hundreds pf web sites and forums as well as many
small Creatures communities who swap information, creatures and new objects. The
Creature Labs web site is speciﬁcally designed for Creatures owners, and provides a wide
range of information ranging from developer data for those wishing to add new objects
themselves to genetics editors and free downloads to enhance your program.

Credits
Design Toby Simpson
Additional design Robin E. Charlton, Mark Ashton, the
Creatures development team
Lead Programmer and systems design Robin E. Charlton
Lead Agent Engineer and ecology design Mark Ashton

Internet resources

Programming Ben Campbell, Robert Dickson

With hundreds of web sites out there, the best place to start is a search engine. Try typing
“Creatures, Creature Labs, Norn” into the keywords box, and see what comes out.

DirectX “stuff” Chris Wylie
Macintosh programming Keith Hook

Caution: Creature Labs do not control the content of third party web sites, and take no
responsibility for the material presented on them.

Agent Engineering John “But why?” Ferguson
Genetic Engineering Sandra Linkletter

Exchanging Norns on the Internet
The Norns in Creatures 2 can be easily stored on your hard drive, or even e-mailed to a
friend over the Internet. You can use the “Export Selected Creature” option on the File
menu to remove a Creature from Albia. Once you have selected a folder to store your
creature in, a ﬁle will be created that contains it. By default, it will be called “creature_name.
exp”. For example, if you exported a creature called Alice to your desktop you’d get a ﬁle
called “Alice.exp”.
This ﬁle can be then e-mailed as you would e-mail any other ﬁle – check out the
instructions for your e-mail program to ﬁnd out how to send attachments. You can also put
Norns onto your own personal website so that other users can have a look at them too.
If you wish to send a Norn directly by e-mail without having to go through the exporting
stage, you can use the “Send to” option on the File menu.

Adding new objects
Every plant, animal and insect in Albia is a separate system called an autonomous agent,
or just “agent” for short. Most people just refer to them as objects. You can add new agents
into Albia in many ways. Both the Health Kit and Breeder’s Kit have pages for you to add
medicines into Albia. In the same way that this works, you can also add many other objects.
Creature Labs develops a collection of new agents, some of which are free to download
from our web site, and will be available on add-on CD-ROMs. In addition to Creature Labs’s
agents, many Creatures users have learnt how to develop their own agents.
Use the Agent Injector to add new agents into Albia, as well as analysing them for possible
danger beforehand.

Additional Genetic Engineering Eric Goodwin
Art Direction Colin Swinbourne
Graphic Artists Claudio Berni, Ceri Llewellyn, Darren
Thomas, Paul Simon, Sean Nicholls,
Colin Swinbourne
Introduction Sequence modelling Claudio Berni, Ceri Llewellyn
Neuroscience and brain remodelling Dylan Banarse
In game music Peter Chilvers
Sound effects Oscar Wilkinson, Mark Ashton
Intro sequence music, post production Richard Joseph
Additional prototyping and Gary Buckley, Dharmesh Raithatha,
development Alima Adams
QA and Production Manager Ben Simpson
Manual and help ﬁle Toby Simpson
Quality Assurance The Creatures Team, Oscar Wilkinson,
Tytn Hayes
With thanks to Howard Newmark, Lisa de Araujo,
Lee Singleton, and David Bishop
Original Creatures concept and design Steve Grand, OBE
Creatures is © 2004 Gameware Development Ltd. All rights reserved.
Creatures is a registered trademark of Gameware Development.

26 - Creatures 2

Creatures 2 - 27

